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Executive summary 

This white paper provides instructions for creating the Microsoft® Windows® 7 Professional with 

applicable HP drivers and applications for select HP Elite and HP Pro Business Desktop PC models. 

Instructions are provided for creating a common image across HP Compaq Elite 8300 and HP Compaq 

Pro 6300 business desktop models. 

HP recommends using the HP Elite 8300 preinstalled image as the basis for development of a 

customized common image. HP business desktop models have been through the HP Total Test Process, 

which involves over 115,000 hours of testing in order to provide you with a more reliable and stable 

PC computing experience. 

Target audience: This white paper is intended for IT staff. 

System requirements and prerequisites 

Information regarding minimum hardware requirements for the installation of Windows is available at 

http://www.microsoft.com. 

Supported models 

 HP Compaq Elite 8300 Convertible Minitower PC  

 HP Compaq Elite 8300 Microtower PC  

 HP Compaq Elite 8300 Small Form Factor PC  

 HP Compaq Elite 8300 Ultra-slim PC  

 HP Compaq Pro 6300 Microtower PC  

 HP Compaq Pro 6300 Small Form Factor PC 

WARNING 

Before proceeding with the installation or configuration of Windows, 

you should back up all personal data, such as files and images. If it 

is not backed up, your personal data could be lost.  

The following items are needed to install Windows: 

 A supported HP business desktop PC model 

 Windows OS recovery media provided by HP 

– Media from an alternate source may require a product ID (PID)1 

 Access to Drivers/OS enhancements provided by HP 

– HP SoftPaq Download Manager (www.hp.com/go/sdm) 

– High speed Internet access (www.hp.com) 

– HP System Recovery Supplemental Disk 

                                                
1 Typically provided on the product’s Certificate of Authenticity 

http://www.microsoft.com/
file://jbhnas/Backup/MarComm/White%20Papers/2011/Approved%20by%20legal/www.hp.com/go/sdm
file://jbhnas/Backup/MarComm/White%20Papers/2011/Approved%20by%20legal/www.hp.com
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IMPORTANT 

Make sure you have the latest compatible versions of drivers and 

enhancements (Table 1). In addition, you must have a Microsoft 

operating system license for each system on which you install 

Windows 7 Professional. Deploying Windows images requires 

special license provisions from Microsoft. For more information 

please visit www.microsoft.com/licensing/.  

Common Image 

Advantages of a Common Image 

Creating a common image has several advantages. 

 Image reduction—by creating a product family-based common image, image management 

becomes easier because the number of images that require management is reduced. 

 Operating System-controlled driver installation—by implementing the .inf file-based driver 

installation method outlined in this white paper, it is assured that hardware will be installed in 

the most optimal manner possible. 

 Image validation—by using the image preinstalled by HP, you will start with an image that has 

already undergone extensive testing and validation with the hardware on which it will be 

deployed. This will save considerable testing resources in your environment. In addition, using 

the HP image as a base will bypass the Microsoft Windows Activation process that requires 

each user to activate their copy of Windows 7. 

 

Limitations of a Common Image 

While the use of a common image can be extremely advantageous, it is not without caveats. Creating 

a common image causes a shift in the support liability from the PC OEM back to the organization 

creating the common image. 

It is also very important to be aware of the operating system license as well as licensed applications 

that are part of the common image. Royalty-based applications typically have strict guidelines 

surrounding deployment and usage. For example, devices such as DVD’s have strict distribution 

restrictions regarding how DVD software is distributed. 

Contact your Microsoft licensing representative for the proper operating system license. 

 

Customizing the Preinstalled Image 

This section provides guidelines when using the HP Elite 8300 preinstalled image as a base upon 

which to build a common image. 

Choosing a Base Image 

As mentioned previously, HP recommends beginning with the factory preinstalled image as the base 

image. If the file system type or the partition structure is not desirable, HP recommends that you still use 

the factory preinstalled image to build the common image. File system and partitioning can be 

customized during the image load phase of the deployment process. 

Windows 7 preinstalled images support an F11 restore-feature, which allows a clean factory 

preinstalled image to be restored by rebooting the PC and pressing F11 at the start of the reboot. After 

pressing the “NEXT” button, check the “Recover the factory installed operating system, drivers and 

http://www.microsoft.com/licensing/
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applications” option and accept the default prompts. The “HP Backup and Recovery Manager” PC 

Recovery will restore the factory preinstalled image to the system. 

If the factory preinstalled image has already been removed from the hard drive, you can restore that 

image using the System Recovery Restore DVD created from the Recovery Manager / Recovery Disk 

Creation application on a system with the preinstalled image or from HP technical support. 

Another option is to perform a clean installation directly from operating system media. Reference the 

Microsoft Corporate Deployment documentation in order to build the base image, and then continue 

with the next section of this document to build a common image. 

 

Customizing the Image 

There are several actions you can take to customize an operating system image before capturing and 

deploying that image: 

• Removing preinstalled software 

• Adding software 

• Adding hardware/drivers 

• Additional customization 

 

Removing Preinstalled Software 

HP pre-installs several applications and software packages that provide additional value to customers. If 

you do not want to include these applications in the common image, they can be removed by using the 

Add or Remove Programs utility, located in the Control Panel. 

Note 

Software marked as a “Hotfix” should be removed. Your system 

ships with fixes and security updates from Microsoft. HP recommends 

that you do not uninstall these updates. In addition, any operating 

system Service Packs preinstalled by HP cannot be removed.  

Adding software 

Please refer to the documentation provided by software vendors on a case-by-case basis for installing 

additional, non-HP provided software on the image. 

 

Adding Hardware/Drivers 

The addition of peripheral hardware devices can necessitate the installation of associated drivers. 

These drivers can be downloaded using HP SoftPaq Download Manager (available from 

www.hp.com/go/sdm); alternatively, you can download individual SoftPaqs from the HP website.  

For more information, refer to Appendix A: Using HP SoftPaq Download Manager. 

 

 

www.hp.com/go/sdm
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Clean Installing the OS, drivers, and enhancements 

This section provides guidelines for users performing a clean installation of Windows on a supported 

HP business desktop PC. 

For more information on installing Windows, refer to the Microsoft website at 

http://windows.microsoft.com/help. 

IMPORTANT 

Follow the installation instructions in the order provided. Failure to 

complete these steps in the proper order can result in an unsuccessful 

or unstable installation. These instructions are independent of the 

operating system currently installed on the PC. 

1. Depending on the particular Internet connection(s) being used, download the driver(s) for the 

network interface card and/or wireless LAN adapter driver. Save to a USB storage device or 

optical media. 

– Contact your network administrator to properly set up the networking components of Windows. 

2. Change the boot order in F10 Setup so the optical drive is the first boot device. 

3. Boot with the Windows 7 OS disk; follow the on-screen instructions for installation. 

– OS recovery media from HP does not require a product ID or key for installation on a supported HP 

business desktop PC. 

– If using Advanced format hard drives (4K sector drives), please refer to the HP white paper 

“Preparing Advanced Format hard drives for Microsoft Windows installations on HP Business 

Notebook PCs and Desktop PCs.” 

4. Install the appropriate communications driver from either the optical media or USB storage device 

(Step 1 above) and configure your Internet connection. 

5. Install the desired patches from www.microsoft.com/windowsupdate or contact your network 

administrator for additional updates. Reboot the system after these patches have been installed. 

6. Install the drivers and enhancements listed in Table 1 using HP SoftPaq Download Manager 

(available from www.hp.com/go/sdm); alternatively, you can download individual SoftPaqs from 

the HP website. Some deliverables may have direct dependencies on other deliverables that may require 

.NET. 

For more information, refer to 

http://windows.microsoft.com/help
http://www.microsoft.com/windowsupdate
http://www.hp.com/go/sdm
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Appendix A: Using HP SoftPaq Download Manager. 

 

Drivers and enhancements 

Table 1 lists minimum recommended drivers and enhancements for Windows 7 Professional.  The table 

also includes dependencies on .NET Framework (if applicable). Required drivers will vary depending 

on hardware configurations deployed in your environment.  
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Table 1. Minimum recommended software versions 

Name Version 
Win 7 

x86 

Win 7 

x64 
Priority 

.NET 

Required 

Driver – Audio 

Realtek High-Definition Audio Driver 6.0.1.6582 A X X 
Required 3.0 

HP SRS Premium Sound 1.12.76.0 A X X 
Optional N/A 

Driver – Chipset 

Intel® Chipset Support 9.2.0.1030 F X X 
Required N/A 

Intel® AMT LMS_SOL for AMT 8.xx 8.0.3.1427 G X X 
Required 3.5 SP1  

Intel® USB 3.0 Drivers 1.0.3.214 D X X 
Required N/A 

Driver – Graphics 

AMD Windows 7 Graphics Driver 
8.940.11.0000 

E 
X X 

Required 3.5 SP1 

Intel Graphics Driver 8.15.10.2696   Rev. R  Rev. P 
Required 3.0 

NVIDIA Graphics Driver 
8.17.12.96.19 

G 
X X 

Required 3.0 

Driver – Network 

Broadcom NIC Drivers 
Multiple 

versions 
15.2.4.1 F 

15.0.4.2 

E 

Required N/A 

Intel PRO/1000 Drivers 16.8_257663 L X X 
Required N/A 

Broadcom 2070/20702 Bluetooth Driver 6.5.1.2700 A X X 
Required N/A 

Broadcom Wireless LAN Driver 

802.11a/b/g/n 
5.100.82.105 A X X 

Required N/A 

Intel® My WiFi and Wireless LAN Driver 15.1.0.18 A X X 
Required N/A 

Ralink 802.11n Wireless LAN 3.2.12.0 A X X 
Required N/A 

Driver – Storage 

Alcor Micro Smart Card Reader Driver 1.7.28.0 A X X 
Required N/A 

Intel Rapid Storage Technology Driver 11.1.0.1006 X X 
Required 3.5 SP1 

Priority Key 

Required - Mandatory for optimal hardware support 

Recommended - HP recommends installing for optimal system performance 

Optional - Value-add software for desired solution 
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NOTE 

 

Building a common image 

Instructions are provided for building Windows 7 Professional images. 

Windows 7 Professional 

1. Install Windows 7 Professional on a supported platform. 

2. Copy all device drivers to the %SystemDrive%\DRV folder. 

3. Run Windows System Image Manager to create the sysprep.xml file.  

4. As shown in Figure 2, make the following changes to the sysprep.xml file:  

– In the Microsoft-Windows-PnpCustomizationsNonWinPE component – 

Set the PnP driver search path. 

– In the Microsoft-Windows-Deployment component –  

Following the pass=”auditUser” phase, set Reseal in OOBE mode. 

NOTE 

Figure 2 does not show the complete sysprep.xml file. 
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Figure 2. Example of sysprep.xml file 

 

 

5. Copy sysprep.xml to % SystemDrive%\Windows\System32\Sysprep. 

6. Run the following command: 

  sysprep /generalize /audit /shutdown /unattend:sysprep.xml 

7. After shutting down the system, use hard-drive duplication software to deploy the common image. 
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Appendix A: Using HP SoftPaq Download Manager 

Using HP SoftPaq Download Manager to update the current platform 

1. Boot the Windows OS. 

2. Open Microsoft Internet Explorer. 

3. Download and install HP SoftPaq Download Manager from www.hp.com/go/sdm. 

4. Launch SoftPaq Download Manager. 

5. When prompted, select Show software for this model only (Figure A-1).  

NOTE 

Use the Check software updates for this model option to 

automatically install the updates on the current system or to 

download SoftPaqs to install on systems similar to the current 

platform. 

 
Figure A-1. SoftPaq Download Manager menu  

 

 

6. The current platform will automatically be displayed and selected in the Product Catalog window. 

7. Select the desired SoftPaqs from the Available SoftPaqs list (Figure A-2). 

 

http://www.hp.com/go/sdm
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Figure A-2. Available SoftPaqs list  

 

 

8. After selecting the desired SoftPaqs, the following options are available in the Downloaded SoftPaqs 

window: Download Only, Download and Unpack or Download and Install (Figure A-3). 

 
Figure A-3. Downloaded SoftPaqs window  

 

 

 Download Only – this option will download all selected SoftPaqs to “C:\ProgramData\HP\HP 

SoftPaq Download Manger\SWDownload”. 

 Download and Unpack – this option will download all selected SoftPaqs to “C:\ProgramData\HP\HP 

SoftPaq Download Manger\SWDownload” and unpack each individual SoftPaq in a unique folder 

based on SP#: (i.e. \SPxxxxx).   

 Download and Install – this option will download all selected SoftPaqs to “C:\ProgramData\HP\HP 

SoftPaq Download Manger\SWDownload” and then install each individual SoftPaq on the current 

system.   



 

12 

Using HP SoftPaq Download Manager to download SoftPaqs for multiple 

platforms 

1. Download and install HP SoftPaq Download Manager from www.hp.com/go/sdm on any 

Windows based system. 

2. Launch HP SoftPaq Download Manager 

3. When prompted, select Show software for all supported models (Figure A-4). 

 
Figure A-4. SoftPaq Download Manager menu  

 

 

4. Select the respective platforms in the Product Catalog window. 

5. Select the appropriate Driver and Operating System Enhancement SoftPaqs from the Available 

SoftPaqs list (Figure A-5). 

 
Figure A-5. Available SoftPaqs list  

 

 

 

 

http://www.hp.com/go/sdm
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6. Prior to downloading the SoftPaqs, set your download preferences in the Configuration Options 

window (Figure A-6) accessed from the Tools menu (Tools -> Configuration Options). 

 
Figure A-6. Download tab in Configuration Options window  

 

 

7. Additional customizations are available through the Unpack tab (Figure A-7). 
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Figure A-7. Unpack tab in Configuration Options window  

 

 

 Unpack Directory – this field allows the user to change the location where the SoftPaqs will be 

unpacked once they are downloaded. 

 Unpack Folder Options 

– Legacy Behavior – this option will unpack all selected SoftPaqs in the Download Directory 

established on the Download tab (above). Unpack directory field will be locked. 

– Separate by SoftPaq IDs – this option will unpack all selected SoftPaqs in the folder designated in 

the Unpack directory. Individual SoftPaqs will be unpacked in a unique folder based on SP# (i.e. 

\SPxxxxx) according to SoftPaq category (Driver – Video, Driver – Audio, etc.). Figure A-8 shows 

an example of this folder structure. 
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Figure A-8. Example of folder structure separated by SoftPaq IDs 

 

 

– Separate by SoftPaq Names – this option will unpack all selected SoftPaqs in the folder designated 

in the Unpack directory.  Individual SoftPaqs will be unpacked in a unique folder based on SP 

Name (i.e. HP Universal Camera Driver) according to SoftPaq category (Driver – Video, Driver – 

Audio, etc.). Figure A-9 shows an example of this folder structure. 

 
Figure A-9. Example of folder structure separated by SoftPaq Name 

 

 

8. After selecting the desired SoftPaqs, the following options are available in the Downloaded SoftPaqs 

window: Download Only or Download and Unpack (Figure A-10). 

 



 

16 

 
Figure A-10. Downloaded SoftPaqs window  

 

 

 Download Only – this option will download all selected SoftPaqs according to the settings established 

in the Download tab in the Configuration Options dialog.  Default is Single Folder set to 

“C:\SoftPaqDownloadDirectory”. 

 Download and Unpack – this option will download all selected SoftPaqs according to the settings 

established in the Unpack tab in the Configuration Options dialog.  Default is Legacy Behavior 

(unpack in Download directory) “C:\SoftPaqDownloadDirectory”.   

9. After download is complete, the SoftPaqs can either be installed directly or imported into your 

respective management solution. 

For more technical information about using HP SoftPaq Download Manager, please refer to the User 

Guide at www.hp.com/go/sdm. 

http://www.hp.com/go/sdm
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Appendix B: Sample Sysprep.inf files 

Example of Windows XP SYSPREP.INF 
 

[Unattended] 

OemSkipEula=No 

OemPnPDriversPath = 

"Drv\Video;Drv\Nic;Drv\Audio;Drv\Modem;Drv\Misc1;Drv\Misc2;Drv\Misc3;Drv\Misc4;Drv\Misc5;Drv\

Chipset;Drv\KBD;Drv\MSD;Drv\USB;Drv\Network" 

 

InstallFilesPath = "C:\i386" 

 

[GuiRunOnce] 

Command0=c:\Drv\install.bat 

 

[GuiUnattended] 

AdminPassword=* 

EncryptedAdminPassword=NO 

AutoLogon=Yes 

AutoLogonAccountCreation=NO 

AutoLogonCount=1 

OEMSkipRegional=0 

OemSkipWelcome=0 

WaitForReboot=NO 

 

[UserData] 

ComputerName=* 

  

[RegionalSettings] 

LanguageGroup=1 

 

[Identification] 

JoinWorkgroup=WORKGROUP 

 

[Networking] 

InstallDefaultComponents=Yes 

 

[OEM_Ads] 

Background=BACKGRND.BMP 

 

[Data] 

UseBIOSToBoot=1 

 

[SysprepMassStorage] 

PCI\VEN_8086&DEV_2410  = %systemroot%\inf\machine.inf ;INTEL PCI-ISA bridge 

PCI\VEN_1106&DEV_0571 = %systemroot%\inf\mshdc.inf   ;VIA IDE controller 

PCI\VEN_10DE&DEV_01BC = %systemroot%\inf\mshdc.inf   ;NVidia IDE controller 
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Example of Windows 7 SYSPREP.XML 

<?xml version="1.0" encoding="utf-8"?> 

<unattend xmlns="urn:schemas-microsoft-com:unattend"> 

    <settings pass="oobeSystem"> 

        <component name="Microsoft-Windows-International-Core" processorArchitecture="x86" 

publicKeyToken="31bf3856ad364e35" language="neutral" versionScope="nonSxS"  

 

xmlns:wcm="http://schemas.microsoft.com/WMIConfig/2002/State" xmlns:xsi="http://www.w3.org/2001/XMLSchema-

instance"> 

            <InputLocale>en-us</InputLocale> 

            <SystemLocale>en-us</SystemLocale> 

            <UILanguage>en-us</UILanguage> 

            <UILanguageFallback>en-us</UILanguageFallback> 

            <UserLocale>en-us</UserLocale> 

        </component> 

        <component name="Microsoft-Windows-Shell-Setup" processorArchitecture="x86" publicKeyToken="31bf3856ad364e35" 

language="neutral" versionScope="nonSxS"  

 

xmlns:wcm="http://schemas.microsoft.com/WMIConfig/2002/State" xmlns:xsi="http://www.w3.org/2001/XMLSchema-

instance"> 

            <OOBE> 

                <HideEULAPage>true</HideEULAPage> 

                <NetworkLocation>Work</NetworkLocation> 

                <ProtectYourPC>1</ProtectYourPC> 

                <SkipUserOOBE>true</SkipUserOOBE> 

            </OOBE> 

            <RegisteredOrganization>Bmankind</RegisteredOrganization> 

            <RegisteredOwner>Bmankind</RegisteredOwner> 

            <UserAccounts> 

                <LocalAccounts> 

                    <LocalAccount wcm:action="add"> 

                        <Password> 

                            <Value>cABhAHMAcwB3AG8AcgBkAFAAYQBzAHMAdwBvAHIAZAA=</Value> 

                            <PlainText>false</PlainText> 

                        </Password> 

                        <Name>UserA</Name> 

                        <Group>administrators</Group> 

                        <DisplayName>UserA</DisplayName> 

                    </LocalAccount> 

                </LocalAccounts> 

                <AdministratorPassword> 

                    

<Value>cABhAHMAcwB3AG8AcgBkAEEAZABtAGkAbgBpAHMAdAByAGEAdABvAHIAUABhAHMAcwB3AG8AcgBkAA==</V

alue> 

                    <PlainText>false</PlainText> 

                </AdministratorPassword> 

            </UserAccounts> 

        </component> 

    </settings> 

    <settings pass="auditSystem"> 

        <component name="Microsoft-Windows-PnpCustomizationsNonWinPE" processorArchitecture="x86" 

publicKeyToken="31bf3856ad364e35" language="neutral" versionScope="nonSxS"  

 

xmlns:wcm="http://schemas.microsoft.com/WMIConfig/2002/State" xmlns:xsi="http://www.w3.org/2001/XMLSchema-

instance"> 

            <DriverPaths> 

                <PathAndCredentials wcm:keyValue="dfbbff91" wcm:action="add"> 

                    <Path>C:\Drv</Path> 

                </PathAndCredentials> 

            </DriverPaths> 

        </component> 

        <component name="Microsoft-Windows-Deployment" processorArchitecture="x86" 

publicKeyToken="31bf3856ad364e35" language="neutral" versionScope="nonSxS"  
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xmlns:wcm="http://schemas.microsoft.com/WMIConfig/2002/State" xmlns:xsi="http://www.w3.org/2001/XMLSchema-

instance"> 

            <Reseal> 

                <Mode>Audit</Mode> 

            </Reseal> 

            <AuditComputerName> 

                <MustReboot>false</MustReboot> 

                <Name>*</Name> 

            </AuditComputerName> 

        </component> 

        <component name="Microsoft-Windows-Shell-Setup" processorArchitecture="x86" publicKeyToken="31bf3856ad364e35" 

language="neutral" versionScope="nonSxS"  

 

xmlns:wcm="http://schemas.microsoft.com/WMIConfig/2002/State" xmlns:xsi="http://www.w3.org/2001/XMLSchema-

instance"> 

            <AutoLogon> 

                <Username>Administrator</Username> 

                <Enabled>true</Enabled> 

                <LogonCount>3</LogonCount> 

            </AutoLogon> 

        </component> 

    </settings> 

    <settings pass="specialize"> 

        <component name="Microsoft-Windows-Shell-Setup" processorArchitecture="x86" publicKeyToken="31bf3856ad364e35" 

language="neutral" versionScope="nonSxS"  

 

xmlns:wcm="http://schemas.microsoft.com/WMIConfig/2002/State" xmlns:xsi="http://www.w3.org/2001/XMLSchema-

instance"> 

            <ProductKey>xxxxx-xxxxx-xxxxx-xxxxx-xxxxx</ProductKey> 

            <ShowWindowsLive>false</ShowWindowsLive> 

            <TimeZone>Eastern Standard Time</TimeZone> 

            <Display> 

                <ColorDepth>32</ColorDepth> 

                <DPI>106</DPI> 

                <HorizontalResolution>1280</HorizontalResolution> 

                <RefreshRate>75</RefreshRate> 

                <VerticalResolution>1024</VerticalResolution> 

            </Display> 

            <ComputerName>*</ComputerName> 

            <CopyProfile>true</CopyProfile> 

        </component> 

        <component name="Microsoft-Windows-Security-Licensing-SLC-UX" processorArchitecture="x86" 

publicKeyToken="31bf3856ad364e35" language="neutral" versionScope="nonSxS"  

 

xmlns:wcm="http://schemas.microsoft.com/WMIConfig/2002/State" xmlns:xsi="http://www.w3.org/2001/XMLSchema-

instance"> 

            <SkipAutoActivation>true</SkipAutoActivation> 

        </component> 

        <component name="Microsoft-Windows-UnattendedJoin" processorArchitecture="x86" 

publicKeyToken="31bf3856ad364e35" language="neutral" versionScope="nonSxS"  

 

xmlns:wcm="http://schemas.microsoft.com/WMIConfig/2002/State" xmlns:xsi="http://www.w3.org/2001/XMLSchema-

instance"> 

            <Identification> 

                <Credentials> 

                    <Domain>arbor01</Domain> 

                    <Password>nopass</Password> 

                    <Username>installman</Username> 

                </Credentials> 

                <JoinDomain>arbor01</JoinDomain> 

            </Identification> 

        </component> 

        <component name="Microsoft-Windows-Deployment" processorArchitecture="x86" 

publicKeyToken="31bf3856ad364e35" language="neutral" versionScope="nonSxS"  
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xmlns:wcm="http://schemas.microsoft.com/WMIConfig/2002/State" xmlns:xsi="http://www.w3.org/2001/XMLSchema-

instance"> 

            <RunSynchronous> 

                <RunSynchronousCommand wcm:action="add"> 

                    <Order>1</Order> 

                    <Path>net user administrator /active:yes</Path> 

                </RunSynchronousCommand> 

            </RunSynchronous> 

        </component> 

    </settings> 

    <cpi:offlineImage cpi:source="wim:d:/sources/install.wim#Windows 7 ULTIMATE" xmlns:cpi="urn:schemas-microsoft-

com:cpi" /> 

</unattend> 

 

Appendix C: Glossary of Terms 

Product Family—defined as a set of form-factor types within a numerically-defined series. For 

example, the HP Elite 8300 product family consists of the convertible mini-tower, small form factor, 

and ultra-small desktop form factor. While the ultra-small desktop form factor machines are 

considered to be within a product family, their size could dictate some hardware differences 

including possible chipset components. These differences in hardware components do not negate 

the possibility of a common image; however, they do add risk and complexity. 

Clean Install—for the purposes of this paper, defined as an image installed on a system using 

operating system media. 

Common Image—for the purposes of this paper, defined as an operating system image that 

works across multiple hardware platforms such as the Elite 8300 and Pro 6300 products. 

Identical Image—an operating system image that is deployed across machines of a single 

product line, all using the exact same hardware options, or configuration. If you are creating an 

Identical Image, you can disregard the section entitled “obtaining drivers for the product family.” 

Driver Support—in a common image, includes the functionality that can be obtained via an INF-

based install of the driver by the operating system. This includes device recognition and basic 

functionality. However, any functionality that is normally achieved by running a setup program will 

not be available. For information on adding setup application processing, please see the section 

titled “Customizing the Image.” 

Reference Machine—term used to describe the system that is being used to perform work to 

pool drivers, customize software and set OS options and parameters. This will be the machine from 

which the image is captured. 

ImageX—a Microsoft command-line tool for capturing, servicing, and applying Windows 

Imaging Format (WIM) files, which are file-based Windows disk images used by Windows. In 

addition to other tools, documentation and samples to enable the IT professional to perform 

automated deployment of Windows 7, ImageX is available in the Microsoft Windows Automated 

Installation Kit (WAIK) that is available from the Microsoft Download Center as a free download. 

SYSPREP (System preparation tool)—a Microsoft tool that prepares the operating system for 

imaging. This tool must be run before imaging a system and then deploying that image. 

SYSPREP, as well as other useful documentation and tools, can be found on your operating system 

CD obtained either from HP or Microsoft. SYSPREP is located in the SYSPREP folder at 

%SYSTEMROOT%\system32\SYSPREP for Windows 7. 
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For more information  

To learn more about HP business desktop and notebook models, contact your local HP sales 
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